TS 5506 – Graphics and Multimedia – Discussions   
Note: The project for this course is now found at: http://2b2b.org under “Flash Triangle Project”.
The course introduces graphics and multimedia technologies, as learners create a Web interactive animation project. Activities include illustrating with Flash, using animation techniques and special effects. Flash files produce resizable compact full-screen navigation interfaces, technical illustrations, long-form animations, and other dazzling site effects. Flash enables Web designers to import artwork from their favorite bitmap or illustration programs, apply transparency, create morphing effects, add interactivity and sound, and animate them over time. Unlike bitmapped images that are optimized for a single resolution, vector images can adapt to multiple display sizes and resolutions. This is ideal for displaying Web sites uniformly on set-top boxes, hand-held computers, or PCs. This course will also cover how to embed exported Flash movies into HTML documents for play in a browser. Learners are required to take TS7010 prior to taking this course.
Welcome to your Capella University online course, TS5506 - Graphics and Multimedia. This course will cover the basic functionality of Web animation and interactivity. You will learn to illustrate with Flash MX using animation techniques and special effects. Flash files produce resizable compact full-screen navigation interfaces, technical illustrations, animations, and dazzling site effects. Flash enables Web designers to import artwork from their favorite bitmap or illustration programs, apply transparency, create morphing effects, add interactivity and sound, and animate them over time. Unlike bitmapped images that are optimized for a single resolution, vector images can adapt to multiple display sizes and resolutions. You will learn how to embed exported Flash movies into HTML documents for play in a browser. 

Prerequisite: TS5110 - Enterprise Systems and Application Development.

You will have a scheduled break week after the completion of Unit 5. During the break week, there are no scheduled course activities.
Welcome everyone!

If you don't have a project in mind, you may simply create a website with a minimum of 12 page web site including all 10 unit flash exercises featured in this course. Each unit should include a thorough review and samples of unit exercises. Other requirements also should include:

! The Final Project Presentation should be aesthetically pleasing and use a consistent theme throughout. Design: The combination of multimedia elements and content takes communication to a superior level. There is a clear attention given to balance, proportion, unity, and variety. The synergy reaches the intended audience with style. All graphics, video, audio, 3-D, or other enhancements are used effectively to enrich the user's experience. 

! Project runs perfectly, with no technical problems. Navigation: All buttons and navigational tools work well. The sequence of information is logical and intuitive. Menus and paths to all information are clear and direct. The project utilizes a multimedia approach and contains a significant number of well-designed navigational options.I hope this helps! My best, Amar
Learning Goals

By the end of this course, successful learners will be able to: 
1. Demonstrate the basic functionality of Web animation and interactivity by creating Flash documents.

2. Incorporate imported bitmap graphics in the Flash vector-based program.

3. Apply a bitmap mask and a bitmap fill in Flash.

4. Create a file with an animated color tween, an animated shape tween, and motion tweening along a path.

5. Incorporate an invisible button and a rollover button on a Web page, and create a button with sound.

6. Create movie clips.

7. Create Flash documents that demonstrate how to use embedded video files.

8. Incorporate the use of Components by creating a form.

9. Create Flash documents that demonstrate the various ways to use sound.

10. Create and demonstrate a Flash file that includes dynamic text and input text.

11. Create and demonstrate a preloader file for a Flash animation.

12. Participate in the Courseroom discussions, apply feedback, and give constructive criticism of other learners' Web pages.

13. Create a Flash project of your choosing that includes and integrates the skills described in these objectives.
Course Outline 
Unit 01: Background Information, the Flash Interface.

Unit 02: Drawing and Color Tools and Animation.

Unit 03: Shape Tweening, Symbols, and Instances.

Unit 04: Motion Tweening and Bitmaps.
Unit 05: Buttons and Movie Clips.

Unit 06: Action Scripting Basics and Working with Text.

Unit 07: Sound and Components, Forms.

Unit 08: Video.

Unit 09: Publishing and Exporting.

Unit 10: Putting It All Together, Integration.

Requirements

1. Courseroom Participation and Unit Assignments: 45% of grade. 
a. Courseroom Participation 
At least once per week, participate in the Courseroom discussion as indicated in each learning unit. It is recommended that you post responses to the instructor's questions by mid-week, and that you post responses to other learners' responses by the end of each week. 

b. Unit Assignments 
Complete all assignments as indicated in each learning unit. There are two things you are required to post each week: 

  The URL of your Web site, where your Flash experiments and individual project reside.
  Your comments on the work of other learners.

2. Individual Course Project: 55% of grade. 
Complete one individual project designed in consultation with, and approved by, the course instructor. You will develop your project throughout the course as you learn the various tools and techniques of Flash. Refer to the TS5506 Course Project Description.

Grading Criteria 

Your performance will be assessed on a point system and course grades assigned on a percentage basis as defined below. For specific criteria related to this course, please refer to the Scoring Guide on the next page.

All courses in the School of Technology are graded as follows: 
A 90-100%.
B 80-89%.
C 70- 79%.
F Less than 69%.

Resources

Required Texts and Readings: 
Macromedia Flash MX Professional 2004 Using Flash MX 2004 Manual <http://www.macromedia.com/>. 
(Note that this is part of the Flash MX software package and does not have to be specially ordered.)

Rebenschied, S. (2004). Learning Flash MX 2004 (CD-ROM). Ojai, CA: lynda.com. ISBN: 1930727593.

Yeung, R. (2004). Flash MX 2004 H.O.T. (hands on training). Berkeley, CA: Peachpit Press. ISBN: 0321202988.
Required Software: 
Macromedia Flash MX 2004.

Macromedia Dreamweaver MX or higher.
Optional Materials

The optional materials listed below may be useful to you. These materials are not required. 
Besley, K., Bhangal, S., & Farr, A. (2002). Foundation Macromedia Flash MX. Chicago: Friends of Ed. ISBN 1903450101.

Casady, C., & Weinman, L. (2001). Animation principles with Flash 5 CD-ROM. Ojai, CA: lynda.com. ISBN 1-930727-12-7. This resource is highly recommended.

Curtis, H. (2000). Flash Web design: The art of motion graphics. Indianapolis: New Riders Publishing. ISBN 0-7357-0896-7 (Comes with CD-ROM).

David, M., Baltzegar, M., Brossier, V., Caldwell, J., Dalziel, J., Danika, A., et al. (2002). Flash MX magic (3rd ed.). Indianapolis: New Riders Publishing. ISBN 0-735711-60-7 (comes with CD-ROM).

Kerman, P. (2002). Sams teach yourself Macromedia Flash MX in 24 hours. Indianapolis: Sams Publishing. ISBN 0-6723-2371-0.
Online Resources: 

The Internet has a plethora of resources. 
Art Graphic Design Resource <http://www.deezin.com/>. 
Everything a graphic designer could want or need. 

ArtSpeak 101 Eyes on Art <http://www.kn.pacbell.com/wired/art2/artspeak/artspeak.html>. 
Basic site for introduction to the elements and principles of design: color, line, value, shape and form, balance, texture, symmetry and asymmetry, contrast, rhythm, theme, and variation.

Common Internet File Formats <http://www.matisse.net/files/formats.html>. 
Excellent reference for file formats and respective viewers/helper apps.

Creative Hotlist <http://www.creativehotlist.com/index.asp?linkTarget=homePort.asp>. 
Web site of Communication Arts magazine, has a lot of portfolios of designers, artists to look at. Great site to get visual ideas.

Flash Kit Home Page <http://www.flashkit.com/>. 
Another great Flash resource with tons of free how-to's and downloadable examples that you can deconstruct.

Foundations of Design and Typography <http://metatoggle.com/design_crs/contents.html>. 
A course in basic graphic design principles and typography.

Lynda.com. Non-Dithering Colors by Hue <http://www.lynda.com/hexh.html>. 
The browser-safe color chart.

Macromedia eLearning <http://www.macromedia.com/resources/elearning/>. 
Macromedia's eLearning resource guide.

Macromedia Flash Support Center Top TechNotes and Tutorials <http://www.macromedia.com/support/flash/more_issues.html>. 
Top tech notes and tutorials overview.

Macromedia Flash TechNotes: Video Strategies for Macromedia Flash Web Sites <http://www.macromedia.com/support/flash/ts/documents/video_resources.htm>.

Moock.org Home Page <http://www.moock.org/index-2002-aus.html>. 
Wonderful source for Flash. Offers free, downloadable Flash .fla's, step-by-step tutorials, and even workflow suggestions. A "must visit" for any Flash developer.

Webmonkey Multimedia Video <http://hotwired.lycos.com/webmonkey/multimedia/video/index.html>. 
A great overall resource site for multimedia.

WhatIs.com Home Page <http://whatis.techtarget.com/>. 
Definitions for thousands of the most current IT-related words, including a huge glossary of every file format in the world. A great site!

Unit Assignments Summary

Below you will find a table outlining the chapters in the Flash MX 2004 H.O.T. book and the Using Flash MX 2004 manual, which corresponds to the units in the course. The course is organized sequentially and parallels the chapters in the Flash MX 2004 H.O.T. book. Each week, you will read the Flash MX 2004 H.O.T. book and the Using Flash MX manual that came with your software, and view the material on the Flash MX 2004 CD-ROM. You will also be doing the tutorials and lessons in the online help of the software.

Unit Schedule and Corresponding Chapters in Learning Resources. 
---
Project Description 
You will develop your project throughout the course as you learn the various tools and techniques of Flash. Your project should include at least ten of the techniques of Flash listed below.
An animated color tween. 
A shape tween animation. 
A motion tweening along a path. 
Use of a bitmap mask. 
Use of a bitmap fill in any way you choose. 
An invisible button. 
A rollover button with sound. 
A movie clip. 
Use of either a dynamic text or input text file. 
Sound. 
Embedded video. 
A form. 
A pre-loader file for your final posting. 
You will develop a storyboard and script for your project. You will publish your storyboard and script during Unit 5. It will not be a part of your final project deliverable, but it will be an important tool for developing your project.
You will post your experiments in Flash and your course project during each unit.
A note about the exercises from the textbook, Flash MX 2004 H.O.T , by Kymberlee Weil and Lynda Weinman: As we proceed through the course units, we will go through this book and all of the lessons contained on the accompanying CD-ROM. If you read the book, do all the lessons, and look at the other CD-ROMs, you cannot fail to learn Flash; but if you do not, you will be in trouble. Flash has too many complexities to miss anything.
Lessons for the CD-ROM are assigned. In each unit, you are expected to create something original out of the lesson and post it on your Web page. In the beginning, the lessons are simple (e.g., creating circles, squares, and triangles). As you do these lessons, see if you can transfer what you have learned into something you are going to use in your final project. This will become more obvious as you progress through the course. If you have any questions, just ask your instructor.
---
Unit 1
Get to know his or her fellow learners. 
Recognize the organization and procedures for the course. 
Become familiar with using the online help in Flash. 
Define what he or she would like to create in this course. 
Identify the difference in Flash file types, .fla and .swf. 
Become familiar with the interface of Flash: 
q		Create panel sets. 
q	
·	Change panel layouts. 
·	Custom keyboard shortcuts. 
·	Docking and undocking. 
·	Information bar. 
·	Layer controls. 
·	Layer properties. 
·	The document window. 
·	The toolbox. 
·	Timeline. 
Study Presentation
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Read this Learning Unit's Presentation <Javascript:loadPopupWithParm('/webct/RelativeResourceManager/Template/TS5506/Unit01/s_presentation.html','550','450');>. 

u01s1 Install 
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Install the Flash MX 2004 program.
u01s2 Flash MX CD
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Install the Learning Flash MX 2004 CD-ROM, by Shane Rebenschied. 

u01s3 Flash MX Manual 
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In the Using Flash MX 2004 manual read “Introduction”, Chapters 1 and 2. 

u01s4 Movie 
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View the movie lessons called “Introduction” and "Interface" on Learning Flash MX 2004 CD-ROM. 

u01s5 Flash MX Chapter 1 
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Read Using Flash MX 2004 manual, Chapter 1, "Working in Flash." 

u01s6 Project Description
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Review the TS5506 Course Project Description <Javascript:loadPopupWithParm('/webct/RelativeResourceManager/Template/TS5506/Course_Files/project_description.html','550','450');>.

u01s7 Launch Flash 
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Launch the Flash program, and then select the Help menu located at the top of the navigator bar. Select the topic called "Using Flash." The Flash Help will open in your Internet browser application (e.g., Netscape or Internet Explorer). Flash Help is available whenever the Flash application is active. It also contains the complete Flash documentation. If you have been using Dreamweaver, you will be familiar with this layout and method of using online help and documentation. 
Select the "Getting Started" topic on the left (under the Contents tab), and then select the subtopic called "Guide to instructional media." You might need to expand the “Using Flash” topic in order to select the “Getting Started” topic.
Assuming you are new to Flash, take Macromedia's advice and begin with the tutorial called "Introduction to Flash MX 2004." Read all the subtopics of "Flash Basics." You access the online tutorials by selecting Tutorials under the Help menu in the Flash MX 2004 application. If you already have the Flash MX 2004 Help open, select Tutorials under the Contents tab. You may experiment with as much of the material as you wish at any time. Do not expect to absorb all this information at once. Just realize that you can always go back to this online documentation, if you prefer. You can also read this information in the Using Flash MX 2004 manual, Chapter 1, "Working in Flash." 
Select Lessons under the Flash Help menu, and then open the lesson called “Getting Started with Flash.” The lessons open in a small, separate window. All the lessons are interactive. Explore. You might find it useful to switch back and forth between the Flash online documentation and the lessons. The online documentation is more in depth, while the lessons are interactive.

u01s8 Flash Introduction 
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In the Flash MX 2004 H.O.T. book read the Introduction, Chapter 1, "Background Information," and Chapter 2, "Interface.” 
IMPORTANT NOTE: If you are using Windows, do not miss the information on page xxi in the introduction of the Flash MX 2004 H.O.T. book on "Making exercise files editable on Windows systems."
A word of advice: In the Flash MX 2004 H.O.T book, pay attention to the special tips given in the outlined boxes. Get a grasp of these, and you are well into the learning curve ahead.
A note about the exercises from the textbook, Flash MX 2004 H.O.T , by Rosanna Yeung. As we proceed through the course units, we will go through this book and all the lessons contained on the accompanying CD-ROM. If you read the book, do all the lessons, and look at the other CD-ROMs, you cannot fail to learn Flash; but if you do not, you will be in trouble. Flash has too many complexities to miss anything. 
Lessons for the CD-ROM are assigned. In each unit, you are expected to create something original out of the lesson and post it on your Web page. In the beginning, the lessons are simple (e.g., creating circles, squares, and triangles). As you do these lessons, see if you can transfer what you have learned into something you are going to use in your final project. This will become more obvious as you progress through the course. If you have any questions, ask your instructor. 
Assignments and Discussions u01d1 Introduce Yourself 
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Introduce yourself to your classmates and share your personal goals for this course. Tell us about your past experience with graphic programs or with the Flash application.
Describe the project that you would like to work on during this course. It may be difficult to know what you want to do for a project in the beginning of this course. However, this is the time to begin planning. You will be asked post something about this again midway through the course. 
U1D1
Hello, my name is Richard Bloodworth.  For the past several years I have been teaching English in in foreign  countries ( Seoul, South Korea; Tokyo and Chiba, Japan; Prague, Czech Republic; Istanbul, Turkey; Xi'an and Shanghai, China; and now Taipei, Taiwan).  Prior to the English teaching I was employed in mostly arts related activities (I've done portraits, architectural renderings, murals, and illustrations) having studied art and architecture.  I received a BFA degree in drawing and painting from the University of Georgia.   I have lived mostly in Athens and Atlanta, GA in addition to the above mentioned cities and I have traveled around Europe and Asia.  I am now teaching English at the American English School in Taipei, Taiwan.  I am pursuing a Master's in Professional Studies in Education. My previous courses at Capella were ED: 5004/5, 8111, 5006, 814, 7700, 7701 and I am taking this course as an elective though I am especially interested in this area and would like to learn as much as I can during this course about creating Flash animation.
I have done some animation using film so I'm familiar with some of the concepts involved but I haven't used Flash per se. I have several ideas of ideas that can be animated, some involve exponential progression but I'll probably start thinking of some more ideas as I sketch some of my thoughts as the course progresses.
Richard

U1D2  File Types 
Write a paragraph on your understanding of the difference between vector and bitmap files.
Vector files are comprised of mathematical vector points which mathematically describe an object's outline so that the objects are represented in flat and layered shapes similar to paper cutouts.  The file size is much less than with bitmap files so that they can be down loaded much faster.  The image can be increased or decreased in size with no loss of image quality so that the image remains sharp and crisp.  This system is used with Flash, Illustrator, FreeHand, among others.  Bitmap files are composed of pixelated microscopic squares that are listed in files that describe their color, value, size, number, location, etc. and therefore require much more storage space.  When these images are enlarged the outlines become approximated and can become blurry.  This system is used when photographs are scanned and used in FireWorks and Photoshop and other photographic enhancement programs.  A comparison between vector and bitmap technology could be made using a metaphor of offset printing with vector as comparable to line art and bitmap pixels as comparable to screened half tones where the microscopic dots of the half tone can create effects of value, color, and shades of light and dark.
Write a paragraph on how a Flash file differs from an HTML file. Provide an analysis of the differences between a .fla file and a .swf file. 
HTML, or HyperText Markup Language, is based on text code and is more generally accessible on all computers.  Flash is digitally and vector based and connects to plug ins and can be placed within an HTML document. An .fla (for Flash) file is the source document and is the editable root file.  The .exe (a stand alone program file) and .swf (for Small Web File) files can be generated from the .fla files.  A .swf file can be placed within an HTML file (which functions as a container to hold the .swf file) and put onto the Internet and is generally neither editable nor edible.
--technical support letter:
I am taking courses in the school of technology (5110 and 5506).  I can not see how to edit or delete my submissions and often two postings are sent in instead of one.  Also the profiles icon is now missing from these courses.  I am getting a new computer soon which might solve the problem but I can open the school of technology in Windows 98 but my Flash and DreamWeaver programs are installed in Windows XP.  I can open the school of education in XP (ED815) but when I try to open the school of technology in Windows XP my connection to Capella cuts off.  Can someone tell me why this is happening?
Richard Bloodworth    RBloodworth99@yahoo.com

from Jon:    Getting the point across that the primary content of HTML is text is a difficult one. I'm currently teaching an introductory class in HTML, and I spent quite a while convincing students that just because a web page displays a graphic doesn't mean the image is "in" that file. An HTML file is exactly what its name implies, marked up hypertext. It is the browser that makes the images appear according to the instructions handed to it from the HTML file. I was a little surprised how difficult that was to explain to students.
and:   .swf files sure are optimized. I'm currently working on a project to import some video into Flash for delivery on the web. I'm not into video editing and compression yet, but after being given video files that are already compressed, Flash did quite a number on compressing it even further. So much so that our video was basically unusable for the project. We're now attempting to work with the raw video footage (after editing) to see how much Flash will compress the video. What was supposed to take a couple of hours just importing things has now taken a week of tweaking the video import settings.
---
U1D1 to Chris Stahley
Thank you for this resource website which is full of useful information (though some of the links would not open).  Richard Bloodworth
U1D2
Thank you for that graphic demonstration of the difference between vector and bitmap images.  Did you make that with Flash?  Richard
-- 
from 5506
Create a Web page on which to place your ongoing project for us to see during this course. Begin to develop your project as you learn the tools of Flash. 
In Discussion u02d2 Comments, post the URL for your Web page and any experiments and exercises that you have completed. Be prepared to respond to other learners' experiments and questions.
---
Letter to Almasude, Amar 

, None U.S.A.
EMAIL: aalmasude@fmarion.edu
Hello,
I am enjoying the content of this course.  I have been reading the texts and learning disks and hope to do all of the exercises.
I was at first having difficulty in opening some of the course links and sending in assignments but that seems to be functioning well now.
I have a few questions to ask:  My first question to you is: how do you like to be addressed (by what name)?
In TS 5506 the assignment is to:
1) "Create a Web page on which to place your ongoing project for us to see during this course. Begin to develop your project as you learn the tools of Flash. 
In Discussion u02d2 Comments, post the URL for your Web page and any experiments and exercises that you have completed."
2) Also for another class, TS 5110, we are to create a web site.
Can you please suggest to me how and where I can create web sites for these purposes?  Can we use a private site for the purposes of this course or one that is not 
on the World Wide Web?
I am thinking of making a personal web site showing some of my artwork and personal projects.
I also am thinking of making a site about direct democracy and before I enter it into the Internet I would want to be sure that it is in a correct form.
I have several ideas for Flash animation and am looking forward to the class in order to realize them.
Thank you,
Richard Bloodworth
P.S. I sent some of this information to you previously but the Profiles section is not in the CourseRoom so below is my profile for you to read:
Personal Experiences:
For the past several years I have been teaching English in in foreign countries ( Seoul, South Korea; Tokyo and Chiba, Japan; Prague, Czech Republic; Istanbul, Turkey; Xi'an and Shanghai, China; and now Taipei, Taiwan). Prior to teaching English I was employed in mostly arts related activities having studied art and architecture. I received a BFA degree, in drawing and painting, from the University of Georgia. I have lived mostly in Athens and Atlanta, GA in addition to the above mentioned cities and I have traveled around Europe and Asia.
Educational Background:
Clemson University (architecture, literature, calculus, etc. courses)
Georgia State University (art, history, literature, human evolution, political science, physics, astronomy, philosophy, etc. courses)
Georgia Institute of Technology (architecture)
UGA art and history studies abroad in Cortona, Italy
University of Georgia (art, literature, psychology, French, calculus, biology, physical education, philosophy, etc. courses) BFA: drawing and painting. 
previous Capella courses:  ED: 5004/5, 5006, 8111, 814, 7700, 7701.
Hobbies and Interests:
Traveling, and also reading, listening to music, good conversation, watching movies, tennis, swimming, bicycling, to name a few
Installed software programs:
I have several programs on my computer including PageMaker, Illustrator, DreamWeaver, Flash, PhotoShop, Acrobat Reader, WordPerfect and more.
----
Unit 2
Objectives 
By the end of this unit, a successful learner should be able to: 
Apply drawing tools. 
Practice using and apply the color tools. 
Modify and work with graphic objects. 
Create and edit animations. 
Practice using shape hints. 
Study Presentation
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Read this Learning Unit's Presentation <Javascript:loadPopupWithParm('/webct/RelativeResourceManager/Template/TS5506/Unit02/s_presentation.html','550','450');>. 

u02s1 Chapter 3 
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Read Chapter 3, "Using the Drawing and Color Tools," in the Flash MX 2004 H.O.T. book. Do the exercises described. 

u02s2 Movies
file_12.wmf

View the movies, "morepen.mov" and "brushmodes.mov" contained in the movie folder on the Flash MX 2004 H.O.T . CD-ROM. 

u02s3 Drawing and Color 
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View all the movie lessons on the Learning Flash MX 2004 CD-ROM under the "Drawing and Color" topic. 

u02s4 Topics 
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Read the topics "Drawing" and “Working with Color” in the Using Flash MX 2004 manual. 

u02s5 Help Menu 
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In the Flash Help menu, select Lessons. View the lesson, "Illustrating in Flash." There you will find a work area to test out the tools. You can do this any way you prefer: reading the manual and experimenting, or just following one step at a time. A combination of the two might work best, but everyone learns differently. 

u02s6 Working with Color 
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Launch the Flash MX 2004 Help online documentation (select the “Using Flash” topic under the Help menu). Read the topics "Drawing" and “Working with Color” found under the “Using Flash” topic under the Contents tab, or in your Using Flash MX 2004 manual, read Chapter 3, “Drawing” and Chapter 4, "Working with Color.” 


u02s7 Objects 
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In the Flash MX 2004 Help online documentation, look up “objects” under the Index tab. Read the “objects” topic and all of the subtopics under “objects.” Or read Chapter 5, "Working with Graphic Objects” in the Using Flash MX 2004 manual. 
Take note of the tip on transparent gradient colors. You may find this useful in your animations. As you explore all the functions of the gradient tool, you will get ideas for your projects.
NOTE: When you finish a Flash lesson and close the document to go on to the next one, be sure not to save it when the dialog box comes up, unless you give the lesson a different name. You will want to keep the original lesson intact in case you want to refer to it again.
If you are familiar with other drawing programs, such as Photoshop, or vector programs such as Freehand or Illustrator, you will already be familiar with most of these tools. However, there are some additions and differences within Flash, so it will serve you well to learn the tools specific to Flash MX 2004.

Keep in mind that when you are creating Flash movies, you can always return to these lessons, unlock the layers, and see exactly how the file was created. You can look at all the images contained in the library, the timeline, and the scripts, and see how the experts did it.
If you have not done so already, look up "Preferences" in the index of the Flash MX 2004 Help online documentation. You can set preferences for:
·		Clipboard. 
·	Disable timeline docking. 
·	Editing, drawing wettings. 
·	Editing, pen tool options. 
·	Editing, show pen preview option. 
·	Editing, show precise cursors option. 
·	Editing, show solid points option. 
·	FreeHand text on clipboard. 
·	Gradients on clipboard. 
·	Highlight color (Macintosh only). 
·	Pen tool. 
·	Printing options (Windows only). 
·	Shift select. 
·	Show tooltips. 
·	Undo levels. 

u02s8 Chapter 4 
file_18.wmf

Read Chapter 4, "Animation Basics," in the Flash MX 2004 H.O.T. book. 
View the movie lessons under the "Animation Basics,” and “Frame-by-Frame Animation” topics on the Learning Flash MX 2004 CD-ROM 
In the Flash Help online documentation, read the "Creating Animation" topic (found in the Contents list). There is a lot to absorb here, so read through it and experiment. You can also read Chapter 8, "Creating Animation," in your Using Flash MX 2004 manual. 
In the Flash application, select Lessons under the Help menu and then view the "Creating Tweened Animation" lesson. You might find it useful to switch back and forth between the Flash online documentation and the lessons. 

u02s9 Copy
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Copy the "chap_03" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. 
Copy the "chap_04" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the exercises described in this chapter. Make sure you know how to change the dimensions of your movie stage, change the background color, modify movie properties, etc. Understand the functions of frames and keyframes. 

u02s10 Storyboard 
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Review the Example Storyboard Template <Javascript:loadPopupWithParm('/webct/RelativeResourceManager/Template/TS5506/Course_Files/example_storyboard_template.rtf ','550','450');>.

u02s11 Install 
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Install and view Animation Principles with Flash 5 CD-ROM, by Chris Casady and Lynda Weinman. 
Why another CD-ROM on animation? There are many people who can benefit from viewing this informative demonstration of the basic principles of animation. While many learners have seen some of the magical powers of Flash and have seen many cartoon animations, most do not have any idea of the basics of putting together an animation file. The instructor on the CD-ROM, Chris Casady, has created many award-winning animation films before working with the program Flash. He brings the basics of animating to the program in a way that is easy to understand. 
Assignments and Discussions u02a1 Individual Project
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Create a Web page on which to place your ongoing project for us to see during this course. Begin to develop your project as you learn the tools of Flash.
In Discussion u02d2 Comments, post the URL for your Web page and any experiments and exercises that you have completed. Be prepared to respond to other learners' experiments and questions. 

u02d1 Experiments
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After completing the study activities and Assignment 2.1, complete the following: 
Post the URL for your Web page and any experiments and exercises that you have completed. Indicate what you modified from last week and what is new. Include any questions or comments you have. Send an email message to your course instructor if you are encountering problems with your project . How can the instructor be of assistance?
If you purchased the Animation Principles with Flash 5 CD-ROM by Chris Casady, post any comments you may have about it. 

u02d2 Comments
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Comment on the experiments of other learners assignment u02a1 Individual Project. Select a learner who has not already received feedback. 

u02d3 Field Trip 
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We have been working pretty hard on this course, so now let us take a short break and take a field trip! Visit Macromedia Showcase <Javascript:loadPopupWithParm('http://www.macromedia.com/showcase/','550','450');>. Then, on the right side of the screen, select the Flash link under the Browse by Product heading. If you look at any of these Web sites and find one you like, tell us about it. 
Note that Macromedia's Web site is a great resource for useful information about the program Flash, including many tutorials
----
U2D3 Field Trip
Although I am not sure of the nutritional food value of their product, I enjoyed watching the movies in the Ben and Jerry's site.  The animations were done in an entertaining narrative format and offered a good overview of how their ice cream is produced.
Below are some other sites that use animation, perhaps done by Flash:
If you go to the Yahoo.com main page and click on "Kids" you get Yahooligans.yahoo.com which contains several links with animation including science movies (Brain Pop) in Flash. 
www.space.com has some flash animation on the main pages and within the links and animated movies.
This site has several Flash animations:  http://www.bestflashanimationsite.com/archive/vector-graphics/more2.php
Richard
http://animation.about.com/cs/fireworks/
--
cstahley@chubbinstitute.com    Christopher Stahley
Hello Chris,
I have been reading your postings and think they are full of useful information since you seem to be experienced in this area.
I am am somewhat new to this and I wonder if can be a copycat and use your idea of using one section that lists your discussions for each unit and another section that shows your Flash experiments.  I would like to be able to click on the listed topic links like what you've done.  Though I would do it in another style or format (so as not to completely copy your idea! ),   I wonder if you can tell me briefly how that is done and perhaps what software program it is done in.  I've got Flash, DreamWeaver, Illustrator, Photoshop, Freehand, and some more, on my computer.
Any help or suggestions would be greatly appreciated,
Thank you,
Richard
RBloodworth99@yahoo.com
--
The animated logo for the Chubb Institute is particularly catchy.  Looking forward to seeing more.
Richard
---
letter to Brad
Thank you so much for your patience and help in starting my Capella websites.
--
letter to Amar
Hello Amar,
Thank you for your reply. 
I called (from here in Taiwan) the Capella tech support people Monday night (morning to them) and they walked me through opening my web pages (for two courses) using DreamWeaver and how to make hyperlinks so I am going through the exercises and hope to post my URL address when I get more of the experiments done.   I got started the end of the first week of the course because before that I had to go to Hong Kong for my resident visa for Taiwan so I am about to get caught up with all of the readings and exercises.  As you had mentioned to me, there are a lot of readings and exercises, but I plan on doing all of the exercises and reading all of the texts now that I am getting a routine and a system going and have arranged my schedule to devote more time to the course.  I also plan to try to send all of my discussion comments toward the first half of the week.
A few more questions I have for you:  Where is the Using Flash MX 2004 Manual?  It was not sent as a book with the software CD and I can not find it within the software content or even online.  I have used the Help menu but that has a different content than the manual described in the course schedule.
Another is, on the home page of TS 5506 there is a link called Assignments.  Are we to send in all of our discussions and assignments via that entry point?  I plan on having all of my discussions hyperlinked within my Capella web page for 5506 so that they can be clicked on in that way.  Also, there is the CourseRoom Learning Units where the discussions and submissions are entered.
By the way, though I'll put my Flash experiments and discussions on it soon, my URL for TS 5506 is http://vle1.capella.edu/125836 .
Thank you,
Richard
---
UNIT 3
Unit 3 - Shape Tweening, Symbols, and Instances
Objectives and Activities This page lists the unit's Objectives and Learning Activities.
Objectives: By the end of this unit, a successful learner should be able to:  Explore shape tweening.  Use three kinds of symbols:  Graphic.  Button.  Movie clip.  Create and use symbols.  Use the Flash Library.
Study Presentation file_26.wmf

Read this Learning Unit's Presentation <Javascript:loadPopupWithParm('/webct/RelativeResourceManager/Template/TS5506/Unit03/s_presentation.html','550','450');>.
u03s1 Chapter 5  file_27.wmf

Read Chapter 5, "Shape Tweening," in the Flash MX 2004 H.O.T. book.   
u03s2 Shape Tweening file_28.wmf

On the Learning Flash MX 2004 CD-ROM, view all the lessons under "Shape Tweening."  
u03s3 Symbols  file_29.wmf

In the Flash MX 2004 Help online documentation, look up “symbols” under the Index tab. Read the “symbols” topic and all the subtopics under “ symbols . ” Or read Chapter 7, "Symbols, Instances, and Library Assets" in the Using Flash MX 2004 manual.  Select Lessons under the Help menu and view the "Creating and Editing Symbols" lesson. Working with symbols and instances is one of the key ingredients to any animation you will create.  On the Learning Flash MX 2004 CD-ROM, view all the lessons under "Libraries, Symbols, and Instances.”  Read Chapter 6, "Symbols and Instances" in the Flash MX 2004 H.O.T. book.   
u03s4 Order of Layers  file_30.wmf

Learn to create, name, lock, hide, and rearrange the order of layers. Be sure to look at the manual or the online help file for layers, which will be more in-depth. Do not expect that you will retain everything immediately, but the process does become automatic after you work with a number of projects. Just remember that this online help is always there and easy to use. The lesson is an interactive introduction while the online help will give you many details. You can also review Chapter 1, "Using Layers," in the Using Flash MX 2004 manual.  Copy the "chap_05" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the shape tweening exercises described in this chapter. You will find the one on animating gradients a fun exercise to do.  Copy the "chap_06" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the exercises described in this chapter. Learn the big difference between editing a symbol and editing an instance of a symbol. This is a technique used often when creating Flash animation.   
u03s5 Layers Topic  file_31.wmf

In the Flash MX 2004 Help online documentation, look up "layers" in the Index. Read the “layers” topic and all the subtopics under “layers.”  At the same time, select Lessons under the Help menu and then open "Understanding Layers." Do the interactive lesson and play with some of your own images in a new file. Learning how to use layers should become automatic to you after a while and is another KEY element for creating Flash animations. Yes, you can create animation on one layer, but you will soon learn why working with many is so important to any complex creation. You will also see why you need to know how to organize the order of the layers.   
u03s6 Experiments  file_32.wmf

In Discussion u03d1 Experiments, post the URL for your Web site and any experiments and exercises that you have completed. Be prepared to respond to other learners' experiments and questions.
Assignments and Discussions
u03a1 Individual Project:  file_33.wmf

Add one or more new techniques from this unit to your project. After completing this assignment, proceed to Discussion u03d1.   
u03d1 Experiments file_34.wmf

After completing the study and u03a1 Individual Project, complete the following:  Post the URL for your Web site and any experiments and exercises that you have completed. Indicate what you have modified and what is new. Include any questions or comments you have. Send an email message to your course instructor if you are encountering problems with your project . How can the instructor be of assistance?   
u03d2 Comments file_35.wmf

Give feedback to three other learners' posted samples and questions from activity u03d1 Experiments
---
Letter to HIROKO:
Hello Hiroko!
It's great to hear from you!  I am in Taipei, now teaching English at American English School.  After I got your letter I went with a friend from here to go look for a bowling alley (we found one) so that we can go bowling here sometime.  I am also taking an online Master's courses from Capella University (from Minnesota in the USA) so I am busy with that. I've been taking education courses.  The 3 courses I am taking now are: The Future of Education, and 2 Computer courses: one using DreamWeaver for making websites, etc. and the other using Flash for making computer animation.  I plan on going back to the USA in October but after that -- who knows where I'll go?  Maybe I can go back to Japan -- I sure enjoyed being there.  So what else is going on with you?  Are you still working at the same bank, etc?
(After Japan, I think you know I went to Prague in Czech Republic for an English teaching training course afterwhich I traveled around Europe.  My next country to teach in was Turkey in Istanbul and I traveled around there, Greece, Eastern Europe and Russia.  After returning to the USA, I went to China and taught in Xi'an in the Xi'an Translators' College and then in Shanghai.  After going back to the USA I came to Taiwan in May 2003 which is where I am now --- so that's, in a nutshell, where I have been since being in Japan).
Let me hear what's been going on.
See you later,  Richard
--
From: "Hiroko" <hwillow@fd5.so-net.ne.jp>
To: <richblood99@hotmail.com>
Subject: hi!>Date: Sat, 10 Apr 2004 11:21:05 +0900
 Long time no see! How are you doing? This is Hiroko.  I'm always fine.
I've been sutudying English at an English school.  I got some newclassmates last Feb.
We enjoy the class, and going out after school everytime.
Where are you now? If you come to Japan, please let me know.
Do you remember that we played bowring togther? Now I'm practicing. It's fun.

P.S. Here is a transcript of the courses thus far; I'll send some papers as attachments, too:
ED5005	Master's Learner Success Lab	LAB 2	S
ED5004	Societal and Cultural Change	ONLN		A	4	16
ED5006	Survey of Research Methodology		A	4	16
ED8111	The Historical and Social Foundations of Edu	A	4	16
ED7701	Educational Philosophy and Changes		A	4	16
ED814		Evaluating the Effectiveness of the Educ Pro	A	4	16
ED7700	Learning Theory and the Educ Process		A	4	16

Cumulative:  		Credits	 24  	Points	 96 		GPA     4


P.S. Here is a transcript of the courses thus far; I'll send some papers as attachments, too:
ED5005	Master's Learner Success Lab	LAB 2	S
ED5004	Societal and Cultural Change	ONLN		A	4	16
ED5006	Survey of Research Methodology		A	4	16
ED8111	The Historical and Social Foundations of Edu	A	4	16
ED7701	Educational Philosophy and Changes		A	4	16
ED814		Evaluating the Effectiveness of the Educ Pro	A	4	16
ED7700	Learning Theory and the Educ Process		A	4	16

Now I'm taking a course in Flash animation and one in the Future of Education.
---
u4d1 comment to Jon
Jonathan,  Your exercises and first page for your project look really good.  May I ask how you put in your background color in your first index page (in DreamWeaver or perhaps Flash?) and how you achieved the fade-in effect with your project page?  Richard
u4d1 comment to Rob
Rob, Your page looks really good and those links to the tutorials are helpful too.  Thank you,   Richard
--
Christine, I asked that question in another course and I was told that the instructors have the delete button.  There also is no way to edit a submission as of now but that might possibly be changed in the future as the Technology School CourseRoom is a new format.  In the CourseRoom ( I think now they call that format the Learning Space) in the School of Education, deletions and edits can be done -- there are also listings by date and by learner -- so I think there is much more flexibility in that forum or format.   Richard 
--
Kim,
I always liked the Lion Sleeps Tonight -- great vocals -- though I have never seen it performed (it would have to be on film - that was recorded quite a while back) and don't know who sings it.  Have you used motion tweening between the movements of the characters? Richard
--
Lou,
I saw somewhere that you asked about how to make your orbiting type go behind the globe on your index page.  One idea I had is to split the image of the globe and place the two halves of the globe into two layers so that the layers would be: the bottom half of the globe would be the bottom layer, the orbiting type would be the middle layer and the top half of the globe would be the uppermost layer.  The two halves of the globe would need to be matched up exactly for the concept to be effective and this could be done with a precision straight cut or it it might be better to make the cut follow the contours of the coastlines of the continents.  I'm sure there are other ways, but I think that might be one possibility.  Richard
Correction:
The uppermost layer would need to be the upper half of the globe, the middle layer would be the orbiting type, and the bottom layer would be the bottom of the globe.  Richard
--
Kevin,
I think, in your exercises, your paint brushwork has a nice fluid, painterly style such as in caligraphic painting.  By the way, your family name sounds like it might be Korean or Chinese, -- is it?  Richard
--
Gary,
Your index page is well-thought out and all of the elements are integrated.  I'm curious, did you use DreamWeaver or some other program to compose your layouts? And may I ask, how do you make the link from the CourseRoom to your web page?  Richard
--
Mark,
I've enjoyed looking at your site.  I don't know if it is my computer or what but the transition or connection between pages seemed to take a long time -- but once I got them I enjoyed what I saw!  I like the moving Easter Island-type sculptures.  Can  those figures be motion-tweened for a smoother transition in their motion?  Richard 
---
UNIT 5
Objectives 
By the end of this unit, a successful learner should be able to: 
Create buttons. 
Create movie clips. 
Recognize the differences between a graphic symbol and a movie clip symbol and use each appropriately. 
Create an animated rollover button. 
Study Presentation
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Read this Learning Unit's Presentation <Javascript:loadPopupWithParm('/webct/RelativeResourceManager/Template/TS5506/Unit05/s_presentation.html','550','450');>. 

u05s1 Chapter 9 
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Read Chapter 9, "Buttons," in the Flash MX 2004 H.O.T. book. 

u05s2 Lessons
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On the Learning Flash MX 2004 CD-ROM, view all the lessons under "Buttons." 

u05s3 Movie Clips 
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Read Chapter 10, "Movie Clips," in the Flash MX 2004 H.O.T . book. 

u05s4 Buttons 
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In the Flash MX 2004 Help online documentation, look up "Buttons" in the Index. Read the “Buttons” topic and all the subtopics under “Buttons.” Also, read the “Working with Movie Clips and Buttons” topic, found under the Contents tab. At the same time, select Lessons under the Help menu, and then view the "Creating Buttons" lesson. Do the interactive lesson and play with some of your own images in a new file. 

u05s5 Copy 
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Copy the "chap_09" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the button exercises described in this chapter. Experiment with creating buttons, assigning actions, rollovers, and setting mouse events. 
Copy the "chap_10" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the exercises described in this chapter. 
On the Learning Flash MX 2004 CD-ROM, view all the lessons under "Movie Clips." 
In the Flash MX 2004 Help online documentation, look up "Movie Clips" in the Index. Read the “Movie Clips” topic and all the subtopics under “Movie Clips.”

u05s6 URL
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In Discussion u05d1 Experiments, post the URL for your Web site and any experiments and exercises that you have completed. Include the storyboard for your project on your Web site. Be prepared to respond to other learners' experiments and questions. 
Assignments and Discussions u05a1 Individual Project
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Add one or more new techniques from this unit to your project. After completing this assignment, proceed to Discussion u05d1 Experiments. 

u05d1 Experiments 
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After completing the study and assignment u05a1 Individual Project, complete the following: 
Place your new Flash experiments from the lessons you did in the study activities on your Web site. Post the URL here. Indicate what you have modified and what is new. Include any questions or comments you have. Send an email message to your course instructor if you are encountering problems with your project . How can the instructor be of assistance? 

u05d2 Comments 
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Comment on the other learners' new work from discussion u05d1 Experiments
--
u5 comment to Rodney
I think your index page is well-organized.  Did you compose it using DreamWeaver?
I like the falling and exploding word "Flash".
One thought I had about the week 5 project is think perhaps the picture of the boys could pause for a second or so during the loop playback cycle.  Also, I'm wondering, are the downloads coming from your website?  Richard
--
u5 comment to Gary
You seem to have the button concepts down quite well. I like the radially-filled glowing roll-over buttons and the back button (even spelled from back to front!) and I think the subtlety of the rotating star reflection on the exercises buttons is particularly effective.  Did you design most of you page layout in DreamWeaver or some other program?  Richard
--
Amar,  Here are my Chapters 9 and 10 exercises, for Unit 5.  I think learning Flash is fascinating but, as you said it would be, very time-consuming.  Several times the files were not saved when I thought they were so I had to do several of them more than once to get them saved.  I have learned not to just press "Ctrl S" and save them by whatever name is there, I now rename all of the files to save them -- that way I am sure that they get saved.
By the way, I just purchased a Wacom Intuos 2 graphics tablet system, which is a stylus with a drawing, board so I hope to get some effective drawing done in the artwork. ( It's not easy trying to draw with the mouse!).  Richard
http://vle1.capella.edu/125836--
UNIT 6
Objectives and Activities
This page lists the unit's Objectives and Learning Activities. 
By the end of this unit, a successful learner should be able to:  Create interactive movies.  Use ActionScripting commands to control interactive movies.  Create a pre-loader file and a “loadMovie” Flash file.  Use various kinds of type and text and their attributes

u06s1 Chapter 11 
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Read Chapter 11, "Action Script Basics and Behaviors," in the Flash MX 2004 H.O.T. book. 

u06s2 Movies 
file_47.wmf

On the Learning Flash MX 2004 CD-ROM, view the movies under "ActionScripting Basics.” 

u06s3 ActionScript 
file_48.wmf

In the Flash MX 2004 Help online documentation, read the "Writing Scripts with ActionScript," the “Understanding ActionScript,” and the “Creating Interaction with ActionScript” topics. They are found under the Contents tab. Or in the Using Flash MX 2004 manual, read Chapter 9, “Understanding the ActionScript Language,” and Chapter 10, “Creating Interaction with ActionScript.” The “Writing Scripts with ActionScript” topic is only available in the Flash MX 2004 Help online documentation. 

u06s4 Tutorial 
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Read the Flash MX 2004 Help online tutorial “Introduction to ActionScript”. You access the online tutorials by selecting Tutorials under the Help menu in the Flash MX 2004 application. If you already have the Flash MX 2004 Help open, select Tutorials under the Contents tab. 

u06s5 Chapter 12 
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Read Chapter 12, "Working with Text," in the Flash MX 2004 H.O.T. book. 

u06s6 CD-ROM 
file_51.wmf

In the Learning Flash MX 2004 CD-ROM, view all the movie lessons on "Type." 

u06s7 Working with Text 
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In the Flash MX 2004 Help online documentation, read the “Working with Text” topic and read all the subtopics. They are found under the Contents tab. Or read Chapter 6 in the Using Flash MX 2004 manual. 

u06s8 Menu.mov
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View the movies, "menu.mov" and "loadMovieNum.mov,” in the movie folder on the Flash H.O.T. CD-ROM. 

u06s9 Copy 
file_54.wmf

Copy the "chap_11" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the button exercises described in this chapter. 
Create one of your own drop-down menu files that targets particular scenes.
Create a "loadMovie" Flash file. 
Create a "Preloader" file. 
Copy the "chap_12" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T . CD-ROM to your hard drive. Do the exercises described in this chapter. Take special note of the “Font Symbols” section.
Create one of your own dynamic text files for your project. 
Practice changing the font size and colors, placement, and the "break apart" tool for text. Do not underestimate the power and importance of the text tool. After going through the lesson, check "Text" in the online help for more information.
In Discussion u06d1, post the URL for your Web site and any experiments and exercises that you have completed. Export some of your type experiments and scripting. Be prepared to respond to other learners' experiments and questions.

Assignments and Discussion:
u06a1 Individual Project
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Add one or more new techniques from this unit to your project. After completing this assignment, proceed to Discussion u06d1 Experiment. 

u06d1 Experiment
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After completing the study and assignment u06a1 Individual Project, complete the following: 
When you place your new Flash files on your Web site, remember to include the URL here so that we can look at your Web site. Tell us anything about these images you would like us to know. Indicate what you have modified and what is new. Include any questions or comments you have. Send an email message to your course instructor if you are encountering problems with your project . How can the instructor be of assistance? 

u06d2 Comments 
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Comment about the work of the other learners from discussion u06d1 Experiment.

Amar,
I am unable to connect to the CourseRoom and the message block said to contact you.
Thank you,
Richard Bloodworth
RBloodworth99@yahoo.com 
--
Here are the exercises for Chapters 11 and 12.
Richard Bloodworth
http://vle1.capella.edu/125836

Your project is developing a nice narrative flow.  I'll be interested to see the final result.Richard
--
I see that you got the orbit to go behind the globe.  Did you do it by dividing the globe into layers? Just curious.  Richard
--
u6d1 comment to Chris
After following every detailed step I got the scrolling to function (of Chpt 12, ex. 6) within my .swf file on my own computer (by pressing Ctrl-Enter while in the .fla file) but after uploading it into my website it would not scroll but I don't know why. Richard
--
Mark,  
It sounds like you've had quite a bit of experience with web page design (which helps explain your highly developed website).   It's good to hear you mention the traditional skills of drawing and painting (life drawing, painting -- with real paint, etc.) which I think are essential foundations for good visual design.  I just got a Wacom Intuos 2 stylus and drawing board (Have you heard of it or do you have one yourself?) so I hope to use that in the next few weeks.  Richard
--
Amar,
After following every detailed step I got the scrolling to function perfectly (of Chpt 12, ex. 6) within my .swf file on my own computer (by pressing Ctrl-Enter while in the .fla file) but after uploading it into my website it would not scroll but I don't know why.  Also all of the music buttons worked exactly as they are supposed to in the .swf files on my computer but when I uploaded them buttons in exercise 8 about creating a simple music of Chapter 13 the buttons also do not function. (Perhaps I need to look into other methods of uploading the files.)
I've been using "Insert>Media>Flash" to insert the files into the pages and then I upload the pages through DreamWeaver files.
Do you have any suggestions for the best way to upload the files?  Thank you,  Richard
--
Here are the Chapters 13 and 14 exercises.  Again, all of the exercises worked perfectly after I followed all of the detailed steps (on the .swf files played on my computer using Control>Test Movie) but the buttons #1,2, and 3 aren't functioning after I uploaded them through the DreamWeaver files from the exercise 8 in Chapter 13 on Sound.  Also, I tried to make the stop/play selection (from exercise 4 of Chapter 13) not play when the page is loaded but it starts anyway and plays for a few seconds (it did the same on the soundOnOff_Final.fla in the exercises samples also).  The first frame of the timeline in the Actions panel is set with Global Functions>Timeline Control>Stop so it seems that the sound would not start playing automatically.
Richard  http://vle1.capella.edu/125836
---
Here are my Chapter 13 and 14 exercises. Next I plan on putting them onto individual pages. ( Now there are linked with anchor links from after being loaded onto one page.)  Any suggestions are welcomed.
http://vle1.capella.edu/125836
 ---
To Gary
The functionality and organization of your webpage are working really well.  Richard
---
To Christine
Your page is coming along well.  Did you make the moving art slides with a motion tween technique?  Richard
--
Does anyone know how someone could make cut out "paper dolls" or "paper puppets" from imported bitmap graphics or photographs which could then be animated?  Richard
--
To Christine,
Thank you for your reply.  I tried that technique in PhotoShop and, after using the lasso and deleting the background, I imported the image into Flash (it worked with copy and paste or with File>Import in Flash) but the "paper doll" figure is within a rectangle but with a blank white background.  I guess one way of doing that idea, so that there is a shape on the stage, is to draw an outline of the shape and then do a fill with the imported bitmap image but I don't know how (or if) that can be done.  I'll keep experimenting. Thank you,  Richard
---
Kevin Kwong     http://vle1.capella.edu/134484/       kkwong02148@yahoo.com
Kevin,
I like the way your site is laid out.  I need to start putting my pages into a final format. Can you please tell me, briefly, how you made your pages and links and what program(s) you used.  I have DreamWeaver, PageMaker, Illustrator and Flash (and others, such as PhotoShop) on my computer.  I would greatly appreciate any input you can make.  Thank you, Richard
P.S.  Where in China are your ancestors (or you or your parents?) from?  I lived in Xi'an and Shanghai for a year combined last year.
---
Kim Hartford     http://www.soulsationdesigns.com/flash/flash.htm  KIMHARTFORD@HOTMAIL.COM 
Kim,
I've enjoyed looking at your site (I always liked "The Lion Sleeps Tonight" too).  If you have the time, can you tell me briefly how you did the Michael Jackson moving cut-out mouth. I guess it was with an imported bitmap graphic.  Was it in Flash or some other program?   I'd appreciate any input you can make about that. Thank you, Richard
--
Kevin,
Thanks for the information.  (I'll check out your code).  I just came back from Hong Kong in April (so I returned after the TS5506 course started) to get my resident visa for  teaching English in Taiwan.  Hong Kong is an interesting city. Thank you,  Richard
--
u8 Objectives: By the end of this unit, a successful learner should be able to: 
Import, control, and work with video. 
u08s1 Chapter 15
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Read Chapter 15, “Video,” in the Flash MX 2004 H.O.T. book. 

u08s2 Imports
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Using “Imported Artwork and Video” in the Flash MX 2004 Help online documentation and Chapter 10 in the Using Flash MX 2004 Manual, create Flash documents that demonstrate how to use embedded video files. 

u08s3 Copy 
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Copy the "chap_15" subfolder in the exercises_files folder from the Flash MX 2004 H.O.T. CD-ROM to your hard drive. Do the exercises described in this chapter. Do not miss the "Tips for Optimizing Movies" at the end of this chapter. 

u08s4 URL 
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In Discussion u08d1 Experiments, post the URL for your project after you have added the video so that we can look at your Web site. Be prepared to respond to other learners' experiments and questions.
u08a1 Individual Project 
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Add one or more new techniques from this unit to your project. After completing this assignment, proceed to u08d1 Experiments. 

u08d1 Experiments 
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After completing the study and assignment u08a1 Experiments, complete the following: 
Post the URL for your project after you have added the video so that we can look at your Web site. If necessary, tell us what you are attempting to do. Tell us what you did with your video exercises and how and where you integrated video into your project. Indicate what you have modified and what is new. Include any questions or comments you have. Send an email message to your course instructor if you are encountering problems with your project . How can the instructor be of assistance? 

u08d2 Comments 
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Comment on the other learners' new work from u08d1 Experiments.
--
Amar,
This is to let you  know that I fixed (with the help of Capella tech support) the dynamic text scroll in exercise 6 of Chapter 12 and the music selector buttons in exercise 8 of Chapter 13.
Thank you,
Richard
http://vle1.capella.edu/125836
--
Chris,
Your intro and use of a video is well incorporated into your project and as your project develops it should also help to generate interest in and bring new students into the Chubb Institute.  Richard
---
Kim,
Can you please look at this .fla and see how I can get the three music selections to loop playback?  Thank you,  Richard Bloodworth 
for Flash H.O.T. chapter 13, exercise 8
http://vle1.capella.edu/125836

GENERIC:
I am registered for TS 5514 for Summer 2004. 
Could you please email the schedule/syllabus as it appears in the CourseRoom since I would like to print out, in June, the schedule for the class since the printer I would use would be available then.
 Are there required textbooks for the course?
Thank you,
Richard Bloodworth
RBloodworth99@yahoo.com
---
from Gary Booth's final project:
The project includes ten of the techniques of Flash listed below. 
1. An animated color tween. (Logo on pages, except home page )
2. A shape tween animation. ( Course page…green logos)
3. A motion tweening along a path. (Home page logo) 
4. Use of a bitmap mask. (Splash screen calls home page) 
5. An invisible button. (Course page as bullets next to each course listed) 
6. A rollover button with sound. (Throughout the project on the left side) 
7. Use of either a dynamic text or input text file. (Home page at the bottom) 
8. Sound. ( Home page at the top right side) 
9. Embedded video. (Course page CSC104 Information Processing) 
10. A form. (Email information)
---
Yangzi
These are photographs that were taken in 2002 of scenes during a Yanzi River trip.  They depict scenes that will no longer exist after the completion of the world's largest dam in Wuhan, China which will cause the surrounding valley, including these views of the Three Gorges, to fill up and become submerged, creating the world's largest artificial lake.
Resume:

	Richard Bloodworth
	P.O. Box 78123
	Atlanta, Georgia 30357
	tel: (404) 524-9252
	

Education:

University of Georgia; GPA 3.0		1988-90; BFA (art, painting and drawing, minor:                                          	              	  				philosophy with biology, calculus,astronomy,french).
Georgia Institute of Technology		1987,88 (architecture); GPA 3.5
Georgia State University; GPA 3.0		1987-88,73 (art, design, animation, history,literature).  
Portfolio Center				1986 (Jan.-June) (art, illustration, graphic design)
Atlanta College of Art		    		(painting, drawing, printmaking).                

Professional Experience: 
	
	Freelance artwork including architectural renderings, portraits, advertising art, commissioned paintings and murals, illustrations, and graphic design with experience in commercial and fine art printing techniques as well as film making and animation.  Sole proprietor and originator of an expanding line of stationery based on drawings of several cities and distributed throughout the U.S. 

Kojen and American Language Schools  -- teaching English from May 2003 to July 2004 in Taipei, Taiwan.  

Yuncol School  teaching English from April to November 2002 in Shanghai, China.

Xi'an Translators' College teaching English during Winter quarter of 2001-2002 in Xi'an, China.

English Time  teaching English to adults in Istanbul, Turkey from January to July, 2001.	
	
S.E.T., A.T.E. & Oxford Schools of English and company classes through TCLC (Asahi Glass & Diamond Co.s) in Tokyo, Japan beginning June 97, teaching English and math to children and adults. 
	Hampton & Ken Schools of English teaching to Jr. High & adults  in Tokyo, Japan from May 96.
	Pagoda Foreign Language School and Kwanson Institute teaching English to children and adults 		in Seoul,Korea from March 95 to April 96.
	Oxford Book Store autumn 94, Proof of the Pudding catering staff since July 93;
	Atlanta Symphony Orchestra, telephone sales 94; Cafe TuTu Tango staff artist, 94.
	ORCA Arts Camp Instructor, summer 94; Mt. Vernon GA.: animation, drawing, and painting.
	Front desk McWhorter Hall Athletes Dormitory-University of Georgia, winter, spring 1991.
	Artist-in-Residence/counselor at Camp Takajo in Naples, Maine (summer 91).
	Artist-in-Education program, National Endowment of the Arts, Ga. Council of the Arts, '91-'93.
	Design Management --Responsible for architectural renderings, illustrations, and graphic design. 	J.C.Penney Advertising --Responsible for design, layout, and illustration for newspaper ads.
	Seasonal retail sales at Rich's Lenox (Christmas 82), Muse's Lenox ( July 86-February 87), Lord 		& Taylor (Christmas 84), Radio Shack Lenox (Christmas 91), courier for Flash Courier (summer 85). 

Experience with Macintosh software esp. Aldus Freehand/Pagemaker; Adobe Illustrator/Photoshop, Quark and IBM compatible software: Lotus 123, Windows applications and Word Perfect; Autocad ver.12,13. 

Clients include:
Emory University				Don Trousdell design 
Agnes Scott College			Cargill, Wilson, & Acree 
Atlanta City Hall				Mr. and Mrs. George Woodruff
University of Georgia			Mr. Dillard Munford
Fox Theater,  Atlanta			Mr. and Mrs. Stephens Mitchell
John Rooker and Associates		Gov. and Mrs. George Busbee
Athens Country Club			Mr. and Mrs. Henry Cobb
Oglethorpe University			Mayor Andrew Young
Mr. and Mrs. Nicholas Beadles		Lawrence Moens and Associates, Fla.
	Barbar Group Real Estate, Fla.       		Hallmark Group Real Estate	
	Rosser FABRAP, Inc.			Serilogicals, Inc.
	Turner Associates				Ms. Jane Woodruff		
	Theatrical Outfit				Mr. and Mrs James Heery
	Krystal, Inc.				Carl Trimble Architects
	Metroplex/ Gwinnett Place Office Park	Peter Hand Associates
	Yamada Enterprises, Los Angeles, CA	Camp Takajo,   Naples,ME/N.Y.,NY			
	
Galleries and Shows:
	Arts Festival of Atlanta			Nexus Gallery     
	Stanley and Schenck Gallery		University of Georgia Cortona Show
	Emory Dobb Center Gallery		Artwares Gallery

Other Interests:  writing, reading, racquetball, swimming, golf, calisthenics, animation, and film making.
	movie extra in Twist of Fate, In the Heat of the Night, and Andersonville 93 and 94.

Has traveled extensively throughout the United States, and western Europe in 1976 and in 1989, under 	scholarship, with UGA program in Cortona, Italy and in Asia: Korea, Japan, Thailand, HK, and China.

National Honor Society,  Astronomical Society of the Atlantic, Young Careers/High Museum of Art member. 
	Shepherd Spinal Center and Adult Literacy Program volunteer.

Portfolio of artwork, references, and university transcripts: available upon request.                                

	CLIENT LIST:
American Home Inspection Service
Apartment Catalog
Athens, Ga. Chamber of Commerce
Athens, Ga. Federal Savings and Loans
Atlanta Convention Planners
Atlanta Center for Creative Services
Bob Gentile's Steakhouse and Saloon
Boyd Duncan and Associates
Bradfield Associates, Inc.
Cargill, Wilson, and Acree
Chi Chi's Restaurant
Continental Inn
Corral Food Stores
Custom Music Corporation
Custom Products Publications
David Laufer Associates
E. V. Harris Printing Company, Inc.
Emory University
First National Bank of Athens, Ga.
First American Bank of Athens, Ga.
Florence Enterprises, Inc.
Garrett, Lewis, and Johnson
Gas Products Company
Hallmark Business Forms, Inc.
Hope for Children
Houston's Restaurant
Intermedia Artists
J. C. Penney
Kennedy Memorial Gardens
Kiddie City
Kings' Row Fireplace Shop
Law Offices of Winston H. Morriss
Marietta Square/ Vanguard Properties
Martin Associates Architects 
McGriff Enterpris, Inc.
Northtown Corporation
Oglethorpe University
Our Lady of Perpetual Help Cancer Home
Parking Company of America
Peach State Petroleum
Pope-Pettefer Partners, Architects
Rainbow Marketing
Rosser FABRAP, Inc.
Royal Poinciana Playhouse, Palm Beach
Seasons Restaurant
Second Ponce de Leon Baptist Church
Shrine of the Immaculate Conception
Simpson Associates
South Prado Associates
St. James Episcopal Church, Marrietta
Temp Force Temporaries
The Athens Country Club
Turner Associates                    
Agnes Scott College
Atlanta City Hall
University of Georgia
Fox Theater
John Rooker and Associates
Theatrical Outfit
Moens and Associates, Palm Beach
Krystal, Inc.
Metroplex/ Gwinnett Place Office Park
Trousdell Design
Hallmark Real Estate
Trimble Architects
Peter Hand Associates


Individual Clients:

Mr. Dillard Munford
Mr. and Mrs. Stephens Mitchell
Mr. and Mrs. George Woodruff
Gov. and Mrs. George Busbee
Mr. and Mrs. Henry Cobb
Mayor Andrew Young
Ms. Jane Woodruff
Dr. and Mrs. Robert Graves 
Mr. and Mrs. Earl Young 
Mr. and Mrs. Bob Argo
Mr. and Mrs. James Threlkeld
Mr. and Mrs. James Kenan 
Mr. and Mrs. James Jarboe
Mrs. McKee Nunally
Dr. and Mrs. William Reid
Mr. and Mrs. W.H. Arnold
Mr. and Mrs Tom Skinner
Mr. and Mrs. Richard Freeman
Dr. David Termotto
Mr. and Mrs. D.A. Liegerot
Mr. James McCarty
Mr. and Mrs. James M. Mock
Senator Bud Stumbaugh
Mr. and Mrs. R.J. Taylor
Mr. and Mrs. J.W. Thompson
Mrs. Thomas Cook
Mr. and Mrs. Don A. Davis
Mr. and Mrs. Frank T. Davis
Mr. and Mrs. Joseph Bradberry
Mr. and Mrs. Fred Glass
Mr. and Mrs. Brian Howell
Mr. and Mrs. Robert Crisp
Mr. and Mrs. R.J. Dellenback
Dr. and Mrs. Hugh Hatfield
Mr. and Mrs. Barrett Howell
Dr. and Mrs. Paul Keller
Mr. and Mrs. Robert Ermentrout
Dr. and Mrs. George Erwin
Dr. and Mrs. Ned Franco
Mr. and Mrs. John E. Livaditis
Mr. and Mrs. Albert Sams
Mrs. Wally Butts
Mrs. Bivings Crawford
Mr. and Mrs. John Chapman
Mr. and Mrs. James Shoffner
Mr. and Mrs. David Thurman
Mrs. Herbert Bedford
Mr. and Mrs. Robert Hennessy
Mr. and Mrs. Nicholas Beadles
Mr. and Mrs. Hal Dumas
Mrs. Tom Davenport
Mr. Reid McWhirter
Mr. Andrew Lance
Mr. and Mrs. Claude Williams
Mr. and Mrs. James Deely
Mr. Bryan Hyde
Mr. and Mrs. James Austell
Dr. and Mrs. John McCravey
Mrs. L.S. Gold , Seoul, Korea
Text for “About This”
This is a project constructed solely for the purpose of demonstrating techniques and principles using Macromedia Flash MX 2004 that were learned during the course, TS 5506 Graphics and Multimedia, through Capella University as instructed by Amar Almasude and using the text Macromedia Flash 2004 Hands-On-Training by Rosanna Yeung with Lynda Weiman (2004, Indianapolis: Peachpit Press) and the CD-Rom Learning Macromedia Flash MX 2004 with Shane Rebenschied.
The course occurred during the spring of 2004.
I hope you enjoy visiting and exploring this site.
Sincerely,
Richard Bloodworth
---
Here is the near to completion final project:
http://vle1.capella.edu/125836/
Richard Bloodworth
---
u10 comment to Chris
Chris,
Your site really displays your knowledge of Flash and computer functionality.  Sites such as yours can be utilized for promotional and instruction use and also they can continue to grow and change as time goes by:  new information can be added and new sections can be amended as they are needed.   Richard
----
u10 comment to Kevin
Kevin,
I enjoyed going through your site.  It is a great way to learn more about Bruce Lee.  He had a short life but I think he affected and influenced many people in a positive way.
Richard
--
Christopher,
I hope the new CourseRoom has a way to edit submissions.  I noticed that an "h" was missing in your name but the message had already been sent. Richard

Richard
for CGI forms, etc. :  dynamicdrive.com
http://www.macromedia.com/support/flash/     http://www.macromedia.com/devnet/mx/flash/   http://www.macromedia.com/cfusion/exchange/index.cfm?view=sn110
http://vle1.capella.edu/support/
flash manual tutorials:  http://www.moores-landing.com/flash_user_manual/appendix/appendix_index.htm
http://www.lordoftherings.net/effects/prologue_frame.html    Lord of the Rings
cstahley@chubbinstitute.com    Christopher Stahleyhttp://ap.wacom.co.jp
Macromedia Flash Development Center  http://www.macromedia.com/devnet/mx/flash/
Macromedia Flash Exchange  http://www.macromedia.com/cfusion/exchange/index.cfm?view=sn110
Macromedia Flash Support    http://www.macromedia.com/support/flash/
For TS5506 you have a VLE account: 
FTP Server: vle1.capella.edu 
NT User Name: 125836 
NT Password: rb125836 
Remote Directory: 125836 
URL: http://vle1.capella.edu/125836
 
Learners:
Jon  Jonathan Wyse    http://vle1.capella.edu/124321/       wyseguyonline@yahoo.com
Rob RodenParker      http://www.lc.capellauniversity.edu/~134220/   ROBWORK@RAZZTEK.COM
Elke Hinze       http://www.plumeriawebdesign.com  brad_elke_hinze@verizon.net 
Jason Brittsan    http://www.winisp.net/jasonwoodz/ts5506  JASONWOODZ@HOTMAIL.com
Kim Hartford     http://www.soulsationdesigns.com/flash/flash.htm  KIMHARTFORD@HOTMAIL.COM 
Harry Stearns      http://vle1.capella.edu/130304/index.html     hstearns@chartermi.net
Christopher Stahley    <http://vle1.capella.edu/108892/u04d1_ch7.htm  cstahley@chubbinstitute.com
Mark Trappett     http://vle1.capella.edu/118555/    http://vle1.capella.edu/118555/prjHome.html   markt3@cox.net
William McCain    http://vle1.capella.edu/119609/unit3/     wjmccain@earthlink.net
Louis Mangini   <http://vle1.capella.edu/130913/>     manginilou@yahoo.com
Gary Prandi    http://vle1.capella.edu/118057/index.html   garyprandi@aol.com
Kevin Kwong     http://vle1.capella.edu/134484/       kkwong02148@yahoo.com
Rodney Ivers     http://vle1.capella.edu/019241/TS5506/index.html   rodney.ivers@hp.com
Russ Wright    http://vle1.capella.edu/115085/TS5506/Unit4/unit4flash.htm    rwrigh10@tampabay.rr.com
Christine Davis  http://vle1.capella.edu/129978/newhomepage.swf  christineEdavis@classicnet.net
Gary Booth      http://vle1.capella.edu/000914/www/index.htm     gbooth@faculty.sullivan.edu
Sophia Carter-Lee     http://vle1.capella.edu/126970/Flash/Flash%20Assignments    SophiaCarterLee@aol.com
Rodney Ivers final project:  Project File: http://vle1.capella.edu/019241/ts5506/finalfinal.exe Flash Source File: http://vle1.capella.edu/019241/ts5506/finalfinal.fla Flash SWF File: 
sites suggested by Amar Almasude:      aalmasude@aol.com
http://artlung.com/flash/flash_introduction.html

http://www.ristancase.ch/flash.htm

http://members.cotse.com/exavior/flash.htm
Some flash sites:
www.homestarrunner.com 

